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Увод

Програмабилни логички контролер (PLC - Programmable Logic Controller) је микроконтролерски систем у коме су хардвер и софтвер специфично прилагођени индустријском окружењу. Први РLС је развијен 1968. године, као компјутеризовани сурогат електромеханичким управљачким системима. РLС може да замени велики број релеа, контактора, тајмера и других компоненти.

Предности система управљања са РLС-ом у односу на класичне системе управљања су:

1. Потребан је мањи број проводника, мање физичког простора, мањи број резервних делова;

2. Постоjи софтверска подршка за програмирање комплексних управљачких функција;

3. Дијагностичке функције РLС-а и софтвера омогућаваjу брзо и ефикасно откривање грешака;

4. Једноставно програмирање и одржавање програма, као и могућност једноставне и брзе измене секвенци управљања (репрограмирање) без зауствљања процеса, и без потребе за изменама у ожичењу (осим у случају додавања новог улазног и/или излазног уређаја);

5. Модуларна организација РLC-а омогућава једноставно одржавање;

6. Јефтинији су, нарочито у случају сложених управљачких функција;

7. Поузданији су у раду.

У управљачким системима са РLС-ом основна начела пројектовања су остала иста као у конвенционалним системима управљања.

РLС има одговарајућу програмску подршку, спрегу са улазно/излзним уређајима, комуникацију са удаљеним рачунаром или контролером, операторским панелом и/или другим показивачким уређајем, и првенствено обезбеђује функцију логичког и секвенцијалног аутомата у отвореној или затвореној спрези. Он реагује на тренутне вредности стања процеса и реализује унапред дефинисано програмско - логичко управљање. У РLС су уграђене и једноставније математичке операције, које омогућавају раелизацију сложених функција програмског управљања. Због потребе обраде аналогних сигнала, развијене су и нумеричке функције које обезбеђују реализацју сложених закона управљања (РI, РD, РID).

РLС се састоји од централне процесорске јединице (Central Processing Unit - СРU), меморије и улазно/излазних тачака на које се повезују улазно/излазни уређаји. Уређаји који су повезани са PLC-ом, и који шаљу сигнале у РLС називају се улазни уређаји. Сигнали које ти уређаји шаљу називају се улазни сигнали, а места на којима улазни сигнали улазе у РLС називају се улазне тачке. Свакој улазној тачки додељена је локација у меморији (улазни бит), која показује њен статус (који може да буде оn или оff). Улазни уређаји су: фото-електрични сензори, тастери, гранични прекидачи, итд.

На основу програма који је унет у РLС и стања улазних битова, контролер генерше вредност излазних битова у меморији. Излазни битови у меморији су додељени излазним тачкама, и преко њих се излазни сигнали шаљу према излазним уређајима. Излазни уређај може да буде: индикатор, светлосна и звучна сигнализација, мотор, реле, контактор, електромагнетни вентил, итд.
Сви наведени улази и излази су дигитални. Поред њих, већина РLС-ова подржава рад и са аналогним улазима и излазима преко модула за аналогно-дигиталну, односно дигитално-аналогну конверзију.

Код управљања сложеним процесима, код којих постоји велики број улазно/излазних сигнала, могуће је повезати више РLС-ова са централним рачунаром преко посебно развијених комуникационих модула.

Постоји више начина за комуникацију корисника са РLС-ом, а најпопуларнији и најједноставнији је лествичасти (ladder) дијаграм. Симболи и концепти управљања који се користе у лествичастим дијаграмима потичу из релејних шема. За програмирање ових контролера може да се користи и симболички машински језик (STL - Statement List), као и низ других програмских језика развијених за програмирање програмабилних логичких контролера.
Основни принцип рада контролера је континуално скенирање програма. Након почетне иницијализације, процес извршавања програма се састоји од три основна корака:

1. Очитавање статуса улаза микроконтролера. СРU у овом кораку проверава сваки од дигиталних улаза како би утврдио њихов статус (on/off). На таj начин СРU одређује да ли је сензор или прекидач повезан са улазом активан или не. Подаци о стању улаза се уписују у одговарајуће регистре у корисничком делу меморије.

2. Извршење програма. СРU у овом кораку извршава програм, инструкцију по инструкцију. На основу програма (садржаном у организационом блоку ОВ1, који садржи имена функционалних блокова који се позивају) у коме је дефинисан одговор контролера на појаву сигнала на неком од улаза, и на основу познавања стања одређеног улаза из претходног корака, спроводи се одговарајућа акција. Резултати извршења програма привремено се смештају у меморију, да би касније били искоришћени.

3. Постављање статуса излаза. У овом кораку СРU проверава статус дигиталних излаза и по потреби их мења (уколико је тренутно стање, одређено као резултат извршења програма, различито од стања које се имало у претходном).

После извршења трећег корака процесор се враћа на први корак и непрекидно понавља овај циклус (слика 1). Време потребно за један пролазак кроз овај циклус зове се време скенирања, и представља веома важну карактеристику РLС контролера. Краћи програмски код омогућава брже извршавање програма, а самим тим и краће време одзива (реакције) на промене у систему којим се управља.
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Слика 1 Принцип цикличног извршавања програма РLС-а

Програмабилни логички контролер S7-300
Програмабилни логички контролер S7-300 спада у групу контролера средњих перфоманси. Основну конфигурацију чине јединица за напајање, централна процесорска јединица (СРU), улазне јединице, излазне јединице, функцијске јединице и комуникациони процесори које су међусобно повезане, и чине основни модул (main rack) (слика 2). У основном модулу може да посгоји највише 8 јединица.
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Слика 2 Основни модул програмабилног контролера

Ако је потребан већи број улазних и/или излазних јединица, поред основног, могу да постоје и додатни модули (слика 3). Сваки модул може имати своју јединицу за напајање. Веза између основног и додатних модула остварује се помоћу I/O интерфејса који се налазе и у основном и у додатном модулу.

У сваком модулу може да постоји највише по 8 улазно/излазних јединица, функцијских модула и  комуникационих процесора. Централна процесорска јединица СРU315-2DP, коју имамо у лабораторији, дозвољава прикључивање три додатна модула, што значи да је максимални број јединица 32.

Улазно/излазне јединице се деле на дигиталне (дигитални улази и дигитални излази) и аналогне (аналогни улази и аналогни излази). Функцијски јединице су модули који обављају специфичне задатке (температурни модули, јединица за контролу положаја, итд.). Комуникациони процесори су задужени за повезивање програмибилног контролера на комуникационе мреже и омогуће размену података са другим уређајима.

Дигиталне улазне и излазне јединице могу да имају по 8, 16, 32 или 64 улаза, односно излаза. Постоје два типа дигиталних излазних јединица: са релејним излазима и са транзисторским излазима.
У лабораторији постоји јединица за напајање PS 307, СРU јединица 315-2DP, дигитална улазна јединица SM 321 са 32 дигитална улаза, излазна јединица SM 322, са 32 дигитална транзисторска излаза, дигитална улазно/излазна јединиса SM 323 са 8 дигиталних улаза и 8 дигиталних транзисторских излаза и аналогна јединица SM331, са 2 аналогна улаза. У табелама 1-6 дати су основни подаци о овим елементима.
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Слика 3 Основни и додатни модули контролера

	Улаз

	100-240 V АС (85-264 V АС) 
50/60 Hz (47-6ЗНz)

	Излаз
	5 А при 24 V DС , укупно 120 W

	маса

	740 g



Табела 1 Основни подади о јединнци за напајање PS 307

	Потрошња

	0,85 А, 24V


	Број I/O бајтова

	256/4098


	Број тајмера и бројача
	256

	Меморија за кориснички програм

	зависно од MMC картице, до 8 MB

	Радна меморија

	256 kB



Табела 2 Основни подаци о СРU јединици 315-2DP

	Улазни напон

	24 V DC


	Дозвољени улазни напон

	13-30 V DС


	Улазна струја

	7 mА при 24V DС


	Време одзива при укључењу

	4,8 ms mах.


	Време одзива при искључењу

	4,8 ms mах.


	Број улаза

	32 (4x8 улаза+common, 4 кола)


	Интерна потрошња

	15 mА mах.


	Маса

	260 g



Табела 3 Основни подаци о дигиталној улазној јединици SM 321

	Напон

	24 V DС


	Максимална струја оптерећења

	0,5 А по излазу, укупно 4 А по групи


	Време одзива при укључењу

	0,1 ms max


	Време одзива при искључењу

	0,5 ms max


	Број кола

	32 (4x8 излаза+common, 4 кола)


	Интерна потрошња

	5 V DС, 110 mА mах


	Маса

	200 g



Tабела 4 Основни подаци о дигиталној излазној јединици SM 322
	Напон

	24 V DС


	Улази

	Дозвољени улазни напон

	13-30 V DС


	Улазна струја

	7 mА при 24V DС


	Време одзива при укључењу

	4,8 ms mах.


	Време одзива при искључењу

	4,8 ms mах.


	Број улаза

	8


	Излази

	Максимална струја оптерећења

	0,5 А по излазу, укупно 4 А


	Време одзива при укључењу

	0,1 ms max


	Време одзива при искључењу

	0,5 ms max


	Број кола

	8


	Интерна потрошња

	5 V DС, 40 mА mах


	Маса

	260 g



Tабела 5 Основни подаци о дигиталној излазној јединици SM 323
	Улази


	Број аналогних улаза

	2


	Опсег улазног сигнала

	Напонски улази

	Струјни улази


	
	-2.5-2.5V

-5-5V

0-5 V

1-5 V

-10-10 V


	4-20 mА

0-20 mА

4-20 mА

-3.2-3.2 mА

-10-10 mА

-20-20 mА

	Опсег улазног сигнала

	Otpori

	Термопарови


	
	150Ω
300Ω
600Ω
Pt 100

Ni 100


	Type N [NiCrSi-NiSi]

Type E [NiCr-CuNi]

Type J [Fe-CuNi]

Type K [NiCr-Ni]

Type L [Fe-CuNi]

	Резолуција

	12 bita (цела скала)


	Тип излазног податка

	16-битни бинарни податак


	Време конверзије

	2.5 ms



Табела 6 Основни подаци о аналогној јединици SM 331

Повезивање РLС-а
Повезивање РLС-а са рачунаром
РLС се може, преко једног од своја два периферна порта (MPI или PROFIBUS-DP), повезати на USB порт рачунара помоћу USB ADAPTERA (дужине 5m). Јединица за напајање се повезује на наизменични напон 220V.

Повезивање дигиталних улаза и излаза

На слици 4 је приказано повезивање улазних уређаjа на улазну јединицу контролера, као и реализација улазног кола.

[image: image4.emf]
Слика 4: Повезивање уређаја на улазну јединицу СМ 321

На слици 5 приказан је начин повезивања излазних уређаја, као и реализације излазног кола. На слици 6 приказан је начин повезивања аналогних сигнала на аналогни улазни модул, као и реализације излазног кола.
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Слика 5 Повезивање уређаја на излазну јединицу СМ 322
[image: image6.emf]
Слика 6 Повезивање уређаја на аналогну улазну јединицу СМ 331

Организација меморије

Поред саме процесорске јединице и улазно/излазних тачака, важна компонента програмабилног контролера је меморија. Разумевање њене структуре је од суштинског значаја за програмирање контролера. Распоред меморијских локација приказан jе у табели 7.

	Сектор

	Број речи/битова

	Адреса бајтова

	Адреса бита


	I/O

	Дигиталне улазне јединице

	1024 битова

(128 бајтова)

	IB0-IB127

	I0.0 – I127.7


	
	Дигиталне излазне јединице

	1024 битова 

(128 бајтова)

	QB0-QB127

	Q0.0 – Q127.7


	
	I/O process image
	1792 бајтова

	PIW256 – PIW1024

PQW256 – PQW1024

	-

-


	Раднa
меморија
	Бит меморија

	16384 битова 
(2048 бајтова)

	МB0-МB2047

	М0.0 – М2047.7


	
	„Заштићена“ („Retain“) зона

	128 битова 
(16 бајтова)

	МB0-МB15

	М0.0 – М15.7


	
	„Clock“ меморија
	1 бајт

	МBx

	Mx.0 – Mx.7


	S5 timer flags
	256 битова

	-

	Т1-Т256


	C5 counter flags

	256 битова

	-

	С1-С256


	Timer PVs

	256 речи

	-

	-


	Counter PVs

	256 речи

	-

	-


	Data blocks
	1024 блокова
max 64kB


	-

	-



Табела 7 Распоред меморијских локација

I/O област
Битови, односно речи из I/O сектора се користе за размену података са улазно/излазним уређајима (дигиталним, аналогним, функцијским и комуникационим), као и са другим уређајима (актуаторима, сензорима, РLС-овима ...), у случају да је више уређаја повезано у мрежу (Profibus-DP или ProfiNet). Битови који нису додељени некој улазно/излазној јединици могу да се користе као радни битови. 
Битови и бајтови из радног сектора
Могу да се користе само као помоћне променљиве у програму. Садржај ових битова, као и битова из I/O сектора, губи се ресетовањем напајања, осим ако нису дефинисани као „Retain“ област. 
S5 Timer
Постоје две меморијске области које се односе на такозване „традиционалне“ S5 тајмера. То су битови (флегови) кoји показују испуњеност захтева и речи које показују тренутне (текуће) вредности времена свих тајмера. Могуће је користити максимално до 256 S5 тајмера који су нумерисани Т1-Т256. Исти броj се користи за приступ флегу који показује испуњеност захтева. Преостало време тајмера се може прочитати помоћу одговарајућих инструкција. Поред „традиционалних“ тајмера, постоје и IEC тајмери који су реализовани као системске функције.
C5 Counter 
Слично као код тајмера, постоје две меморијске области које се односе на „традиционалне“ C5 бројаче. То су битови (флегови) који показују испуњеност захтева и речи које показују тренутне (текуће) вредности свих бројача. Могуће је користити максимално 256 C5 бројача који су нумерисани С1- С256. Вредност бројача се може прочитати помоћу одговарајућих инструкција. Поред „традиционалних“ бројача, постоје и IEC бројачи који су реализовани као системске функције.

DB Data Block
Блокови података су делови корисничке меморије који се користе за меморисање вредности варијабли. Кориснички програм може приступити подацима записаним у блоку података, као и сваком другом податку. Приликом креирања блока података дефинише се да ли се вредности података у блоку чувају и након нестанка напајања, односно након прекида извршавања програма или се постављају на предефинисану вредност. Блокови података су саставни део корисничког програма.
Адресирање меморијских локација

При адресирању обавезно мора да се наведе ознака сектора, ознаку дужине податка (B - бајт, W - реч, D - дупла реч), адреса почетног бајта (за податке типа бајт, реч и дупла реч) и место бита у бајту (за једнобитни тип податка). Место бита у бајту мора бити одвојено тачком од адресе одговарајућег бајта. На пример, ако желимо да адресирамо улазни бајт 1 и у њему бит 2, требало би написати I1.2. Ако желимо да приступимо речи која почиње бајтом 8 у адресном простору излаза, требало би написати QW8. При раду са развојним програмом STEP 7, згодније је дефинисати листу симболичких адреса, у којој се одређеним меморијским локацијама додељују симболичка имена, па потом, приликом писања програма користити симболичке адресе уместо апсолутних (директних) адреса.

Адресе улаза и излаза
 Адресирање основних I/O Јединица
Дигиталним I/О јединицама додељене су меморијске локације I0.0 – I127.7 (улазне јединице), односно Q0.0 – Q127.7 (излазне јединице). Свакој јединици се додељује адресни простор дужине 4 бајта. I/O јединици која се налази најближе СРU јединици, додељује се бајтови IB0 до IB3 (односно QB0 – QB3), следећој IB4 до IB7 (односно QB4 – QB7), итд. као што је приказано на слици 7.

[image: image7.emf]
Слика 7 Додељивање меморијских локација улазним/излазним jединицама
Ако нека од I/O јединица има више од 32 улаза/излаза, њој се додељује онолико речи колико је потребно да би сваки улаз/излаз имао своју адресу. На слици 8 приказан је начин адресирања програмабилног логичког контролера, настао применом технике аутотамског адресирања:

[image: image8.emf] 
Слика 8 Пример доделе меморијских локација улазним и излазним јединицама
Сваком дигиталном улазу или излазу, додељује се по један бит унутар бајта која се односи на ту I/O јединицу (на слици дат је пример за I/O јединицу са почетном адресом 0).
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Слика 9 Адресе појединачних улаза/излаза

Уколико је потребно, начин придодељивања адреса I/O јединицама се може изменити уз помоћ алата за дефинисање хардверске конфигурације.

Адресирање аналогних I/0 јединица

Аналогним I/О јединицама додељене су меморијске локације PIW256 – PIW1022, односно PQW256 – PQW1022. Свакој јединици се додељује адресни простор дужине 16 бајта. I/O јединици која се налази најближе СРU јединици, додељује се бајтови 256 до 271 (адресе PIW256 – PIW270, односно PQW256 – PQW270), следећој 272 до 287 (адресе PIW272 – PIW286, односно PQW272 – PQW286), итд. као што је приказано на слици 10.
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Слика 10 Аутоматско адресирање аналогних I/O јединице

Уколико је потребно, начин придодељивања адреса I/O јединицама се може изменити уз помоћ алата за дефинисање хардверске конфигурације.

Начини повезивања контролера и рачунара и умрежавање 
Постoји неколико начина повезивања и комуникација рачунара и РLС-а, од нејједноставнијих серијских веза до сложених информационих мрежа. Најчешће коришћени типови су:

MPI (Multi-Point Interface)

Серијска комуникација преко RS485 интерфејса, стандардне брзине 19.2 kbps (маx 12Mbps). Свака CPU јединица има MPI интерфејс, и он је неопходан за програмирање програмабилног контролера. Он се може користити за размену података између оперативног панела и PLC-a, PLC-a и PLC-a или SCADA радне станице и PLC-a (маx до 4 конекције).
Profibus-DP
Превасходно намењен повезивању децентрализованих периферија, актуатора и сензора са програмибилним логичким контролером. Може се користити и за размену између оперативног панела и PLC-a, PLC-a и PLC-a или SCADA радне станице и PLC-a, као и за програмирање PLC-ова. У зависности од дужине мреже, броја чворова и квалитета и типа преносног медија, брзина преноса података може достићи 12Mbps.
Industrial Ethernet (IE)

Информациона мрежа која омогућава међусобно повезивање процесних уређаја и Office апликација (процесори база података, SCADA), и то на нивоу читавих постројења. Подаци се преносе у пакетима. Ову везу карактерише велика брзина преноса, велика удаљеност између појединих чворова мреже и велики број чворова. Овај тип везе се користи за даљинско програмирање и надгледање. Да би се остварио овај тип везе, контролер мора да поседује одговарајућу Ethernet јединицу.

PROFINET (PN)
Настала комбинацијом Profibus-а и Ethernet-а. Индустријска мрежа која истовремено може повезивати децентрализоване периферије са PLC-ом и служити за повезивање управљачких јединица са централним надзорним уређајима и базама података. Главна карактеристика ове мреже је велика брзина преноса података (маx 100Mbps) и могућност употребе стандардне рачунарске опреме у већини апликација. Велики број S7 CPU јединица садржи већ уграђени PROFINET интерфејс.
AS-Interface (ASI)

Интерфејс за повезивање актуатора и сензора. Користи се на најнижем нивоу индустријске комуникације. Главно подручје коришћења су везе са бинарним актуаторима и сензорима. Интерфејс за повезивање актуатора и сензора је нормиран према стандарду EN 50295 и представља произвођачки независтан комуникациони систем (комплетан систем се изводи у високом степену заштите – IP67, због тога што се поставља директно у технолошком процесу).
На слици 11 приказанаје сложена мрежа у којој је примењено неколико начина умрежавања контролера и рачунара. 
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Слика 11 Пример сложене мреже
Програмски пакет STEP 7
Програмски пакет Step 7 је софтверски алат за креирање, програмирање и пуштање у рад комплетних система аутоматског управљања. Основни задатак овога пакета је:

• конфигурисање хардвера и додела параметара;

• конфигурисање комуникације;

• програмирање;

• тестирање система и отклањање грешака;

• документовање и архивирање;

• дијагностика.

Step 7 не служи само за програмирање појединог контролера, већ омогућава дефинисање комплетног пројекта аутоматизације. Једном пројекту може да се придружи више контролера. Сваки контролер С7 300, С7 400 или С7 фамилије може да извршава више програма истовремено (multitasking). Ти програми могу да се извршавају циклично, или су иницирани прекидом. 

Step 7 омогућава структурно програмирање: програм може да се подели на функције и функцијске блокове, који касније могу да се користе као потпрограми или функције у другим пројектима. Самом поделом програма, програм постаје прегледнији и једноставнији за читање и одржавање. Све windows технике за едитовање, као што су drag&drop, cut, сору, paste, контекстни менији десним тастером миша, итд. могу да се користе током развoја апликације.

Меморијским локацијама РLС-а које се користе као варијабле у програму, могу да се придруже симболичка имена и коментари ради лакше читљивости програма. Адреса меморијске локације, заједно са именом, типом променљиве и коментаром, једним именом се назива симбол. Постоје две врсте симбола: глобални и локални. Глобални симболи су доступни свим програмским блоковима који су придружени једном РLС-у, док су локални симболи доступни само програмском блоку у коме су декларисани.
За сваки РLС у пројекту мора да се креира хардверска конфигурација, која представља мапу модула који су прикључени на одређени РLС. Програм може да се креира коришћењем лествичастог (ladder) програма, који је стандардни програмски језик за програмирање РLС-а, симболичког машинског језика (STL) или неког другог програмског језика (FBD, GRAPH, HiGRAPH, CFC ...). Након креирања и компајлирања програма, врши се повезивање са РLС-ом - прелази се у тзв. Online mode. У овом режиму рада могуће је мониторисање и модификовање варијабли, надзор над извршавањем програма, дијагностика квара, приступ системским подацима РLС-а итд.
Step 7 је модуларан софтверски пакет који садржи софтверске алате намењене аутоматизацији процеса, од којих су најважнији:

SIMATIC Manager - SIMATIC Manager је алат за рад са STEP 7 пројектима. То је „главни“ програм из кога се стартују сви остали софтверски алати, како основни, тако и додатни алати који се могу накнадно инсталирати.
LAD, STL, FBD – Програмски едитор који се користи за писање STEP 7 корисничких програма у "Ladder Diagram", "Statement List" или "Function Block Diagram“ програмским језицима.

NetPro – Configuring Networks – Софтверски алат за конфигурисање мрежа.
Setting the PG-PC Interface – Овај алат се користи за подешавање интерфејса за комуникацију између уређаја за програмирање и програмабилних контролера, оперативних панела и других уређаја за аутоматизацију процеса.
Креирање програма
Након покретања Simatic Manager-a, појављује се празан прозор у коме треба креирати пројекат. Након избора опције из менија File -> New… отвара се прозор New Project у коме треба дефинисати име пројекта и фолдер у коме ће бити смештен пројекат (слика 12).
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Слика 12 Креирање пројекта


Следи креирање PLC станице. Прво означите симбол пројекта, и из менија Simatic Manager-a изаберите Insert -> SIMATIS 300 Station (слика 13). У левом делу прозора појављује се нови фолдер са именом SIMATIS 300.
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Слика 13 Креирање PLC станице


Након тога треба стартовати Hardware Configuration Editor, активирањем иконице Hardware у десном прозору пројекта у Simatic Manager-у. Отвара се нови прозор (HW Config), који се састоји из три дела. Горњи леви прозор је радни простор – место где се креира хардверска конфигурација. Доњи леви прозор садржи додатне информације о хардверској конфигурацији. У десном делу прозора се налази каталог хардвера. Уколико хардвер каталог није приказан, изаберите из менија опцију View -> Catalog (слика 14).
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Слика 13 Стартовање HW Config едитора


Хардверска конфигурација PLC-a се креира „превлачењем“ елемената из каталога у радни простор, почевши од монтажне шине (Rail – она мора да се уметне као прва, али се не види у табели конфигурисаног хардвера) , па надаље уметањем једне по једне јединице. Распоред и тип јединица (кодна ознака) мора одговарати стварној конфигурацији PLC-a (слика 14).
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Слика 14 Конфигурисање хардвера
Када завршимо додељивање јединица хардверској конфигурацији, следи подешавање параметара сваке јединице посебно (слика 15). 

[image: image16.emf]
Слика 15 Подешавање параметара у HW Config едитору


Након што је конфигурација потпуно подешена, треба снимити и припремити системске податке (опција менија Station -> Save and Compile) и уписати их у PLC ( PLC -> Download) као што је приказано на слици 16.
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Слика 16 Припрема и упис података у PLC
Следећи корак је креирање табеле симбола. У табели симбола се апсолутним, физичким адресама придодељује симболичко име, што нам олакшава рад са варијаблама и креирање читљивијег програма. Када сте креирали хардверску конфигурацију PLC-а, креиран је и фолдер S7 Program. Када га означите, у десном делу прозора вашег пројекта појављују се три иконице: Source, Blocks и Symbols. Двоструким кликом мишем на Symbols отварате табелу симбола (слика 17).
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Слика 17 Табела симбола


Табела симбола има 4 колоне:

- Symbol - симболичкo име варијаблe и може садржати до 24 слова односно цифара.

- Address - апсолутнa адресa варијаблe.

- Data type - тип података (Bool, Real, INT, Timer...)

- Comment - коментар. 


Креирање програмског блока се може урадити означавањем фолдера Blocks и избором опције Insert -> S7 Block -> Function из менија Simatic Manager-а. У прозору који се тада појављује (слика 18), треба уписати следеће параметре:
Name:


FC1

Symbolic Name:
Funkcija

Create in Language:
LAD

Унос параметара треба потврдити тастером Ok.
[image: image19.emf]
Слика 18 Креирање програмског блока


Истим принципом треба креирати и организациони блок ОВ1 (он садржи имена функционалних блокова који се позивају и од којих се састоји комплетан програм), уколико се већ не налази у фолдеру Blocks.

Двоструким кликом мишем на иконицу FC1 отвара се едитор програма (слика 19). Превлачењем програмских елемената из прозора Overviews формирате инструкције Вашег програма. Сваку нову инструкцију започињете у новој мрежи коју формирате помоћу опције менија Insert -> Network. Уколико прозор Overviews није отворен поступите као што је приказано на слици 19.
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Слика 19 Креирање програма у програмском блоку


Када сте завршили писање вашег кода у FC1, снимите Ваш програмски блок (File -> Save) и затворите прозор (File -> Close).


Сада је потребно извршити позив функције у организационом блоку OB1. Двоструким кликом на OB1 отворите организациони блок, у Overviews прозору пронађите FC1 (слика 20), и превуците је на Network 1. Снимите ОВ1 (File -> Save) и затворите прозор.
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Слика 20 Програмирање позива програмског блока


Програмске блокове OB1 и FC1 треба уписати у PLC. Означите фолдер Blocks и из менија одаберите опцију PLC -> Download (слика 21). Након тога треба преклопник режима рада PLC-а поставити у положај RUN, покренути извршавање програма и извршити тестирање.
[image: image22.emf]
Слика 21 Упис програмских блокова у PLC

Уколико треба унети измене у Вашем програму, поново отворите FC1, извршите измене, сачувајте програм (File -> Save) и из програмског едитора функцију упишите у PLC (PLC -> Download). 


Надзирање извршавања функције се активира преко програмског едитора, отворањем жељене функције и активирањем иконице Monitoring (слика 22).

[image: image23.emf]
Слика 22 Надзирање извршавања програмских блокова
ПРИМЕРИ
Напомена: У основи, примери су базирани на примерима из књиге "Теорија и пракса пројектовања електричних инсталација" проф. др М. Костића, како би студенти имали прилике да упореде технике примене релејних управљачких шема и управљања применом PLC технике. Решења задатака су прилагођена програмабилним контролерима серије S7 300 фирме Siemens.
У лабораторији од улазних уређаја имамо два гранична прекидача, један тастер, два прекидача и један фотосензор. Они су прикључени на улазну јединицу на следећи начин:

	Уређај

	Број
улаза

	Адреса у меморији


	Леви гранични прекидач

	0

	I0.0


	Десни гранични прекидач

	1

	I0.1

	Тастер

	2

	I0.2

	Фото сензор

	3

	I0.3

	Леви прекидач

	4

	I0.4


	Десни прекидач

	5

	I0.5


Од излазних уређаја, постоје две сијалице, црвена и зелена, и две зујалице. Они су прикључени на излазну јединицу на следећи начин:

	Уређај

	Број излаза

	Адреса у меморији


	Зујалица 1

	4

	Q4.4


	Зујалица 2

	5

	Q4.5

	Црвена сијалица

	6

	Q4.8

	Зелена сијалица

	7

	Q4.7


Пример 1
Написати програм који треба да омогући да се укључење осветљења врши преко степенишних тастера и траје унапред одређено време.

Решење
У примеру се за укључење осветљења користе 3 "тастера" (коришћени су у лабораторији постојећи леви гранични прекидач, десни гранични прекидач и тастер). Притиском на било који "тастер" треба да се упале зелена и црвена сијалица, које треба да се угасе после неког задатог времена.

У овом примеру коришћени су следећи симболи:

[image: image24.emf]
За тајмер је потребно дефинисати брoј тајмера (у овом примеру ознака T3). Време које тајмер треба да одброји се задаје при програмирању тајмера (слика 23). Број тајмера је уједно и флег који показује да ли је тајмер одбројао и он је податак типа ВООL и припада меморијској области Т0-Т255.
Таjмер се активира (почиње да одбројава) када услов извршења постане ОN. Ако је услов извршења у стању ON довољно дуго да тајмер одброји, одговарајући флег који показује да ли је тајмер одбројао ће прећи у стање ON, и остаће у том стању све док се тајмер не ресетује или док његов услов извршења не пређе у стање ОFF. Дијаграм рада тајмера је приказан на слици 23. Формат за задавање времена које тајмер треба да одброји је S5T#xHyMzSwMS.
[image: image25.emf]
Слика 23 Тајмер са кашњењем по укључењу

Да би се обезбедило да се тајмер не ресетује по престанку деловања на неки од тастера, његов услов извршења мора да остане у стању ОN довољно дуго времена да тајмер одброји. То се постиже коришћењем SR флип-флопа (слика 24) која чува статус одређеног бита. Ова наредба има два услова извршења, тзв. услов за постављање (S-set) и услов за брисање (R-reset) - Када услов S пређе у стање ON, означени бит М5.7 (као и излаз Q9.3) ће прећи у стање ON, и остаће у том стању све док услов R не пређе у стање ON, без обзира на услов S. У овом примеру сијалице треба да се укључе када се притисне било који од тастера ТS1-ТS3 (услов S), и треба да остану укључене док тајмер не одброји (услов R).

[image: image26.emf]
Слика 24 SR флип-флопа

Одговараjући ladder дијаграм има следећи изглед:

[image: image27.emf]
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Након писања програма, треба извршити повезивање РLС-а са рачунаром и уписати програм у РLС (РLС -> Download). РLС није потребно пребацити у STOP режим приликом уписа програмских блокова.

Пример 2
Написати програм који омогућава да се мотор аутоматски зауставља после времена t од момента пуштања у рад. Предвидети могућност ручног искључења мотора у сваком тренутку.
Решење 
Коришћени симболи:

[image: image29.emf]
Програм:
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Пример 3
Написати програм којим се мотор стартује после времена t од момента притиска на одговарајући тастер и да се зауставља по жељи (притиском на други тастер).
Решење 
Коришћени симболи:
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Програм:
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Пример 4
Написати програм за пуштање у рад два електрична мотора који су на електричну мрежу повезани преко осигурача, прекидача и биметалних заштитних релеа, тако да се мотори, и поред жеље, не могу истовремено пустити у погон притиском на одговарајуће тастере, него се то може учинити са другим тек после времена t рада првог мотора (мотори се пуштају у рад произвољним редом). Искључење сваког мотора врши се притиском на посебан тастер за искључење.
Решење 
Коришћени симболи:
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Програм:
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Пример 5
Два трофазна асинхрона мотора са краткоспојеним ротором (М1 и М2) треба истовремено да раде у jедном погону, док мотор МЗ служи као резерва. У случају деловања повратне биметалне заштите било мотора М1, било мотора М2, аутоматски се укључује мотор МЗ. Пошто се узрок деловања биметалне заштите мотора М1 или М2 отклони, овај се поново укључује и сва три мотора раде заједно време t, после чега се мотор МЗ аутоматски искључује, а мотори М1 и М2 настављају да раде. Укључивање и искључивање мотора М1 и М2 врши се деловањем на одговарајуће тастере Тu1, Тi1, Тu2 и Тi2. Ако се, док мотор МЗ ради са једним од мотора М1 и М2, жели искључити погон, то се може постићи деловањем на тастер за искључење мотора МЗ (ТО) и на тастер за искључење мотора који је са њим радио. Написати програм за овај погон.
Решење 
Коришћени симболи:

[image: image39.emf]
Пошто у лабораторији не постоји довољан број тастера и прекидача, за биметалну заштиту мотора М3, и за тастере за искључивање мотора М1 и М2, употребљени су битови у радној области, чије стање могу програмски да се мењају током извршења програма. 
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Слика 25 Форсирање вредности варијабле

Програмска промена стања неког бита зове се форсирање. Форсирање бита врши из менија избором опције PLC -> Display Force Value (слика 25), након чега се појављује прозор VAR – Force Values. У табелу треба унети варијабле које желите форсирати (колона Address или Symbol) и вредност (Force Value). Десним кликом на варијаблу у табели, отвара се падајући мени из кога бирате жељену операцију (Force или Stop Forcing).

На овај начин не могу погодно да се симулира функција тастери, зато што се они одмах након отпуштања враћају у своје нормално стање. Овде је отпуштање тастера симулирано тзв. детекцијом позитивне ивице. Детекција ивице је постављање одређеног бита у стање NO током само једног циклуса након преласка услова извршења из стања ON у стање ОFF (негативна ивица), или из стања ОFF у стање ON (позитивна ивица). Детекција ивице се може применити над резултатом неке логичке операције (RLO – слика 26; променљива M 1.0 има вредност 1 у току једног циклуса када се резултата логичке операције I 1.0 & I 1.1 промени са 0 на 1; променљива M 1.1 има вредност 1 у току једног циклуса када се резултата логичке операције I 1.0 & I 1.1 промени са 1 на 0) или над неким сигналом (слика 27; променљива M 1.0 има вредност 1 у току једног циклуса када се вредност променљиве I 1.1 промени са 0 на 1; променљива M 1.0 има вредност 1 у току једног циклуса када се вредност променљиве I 1.1 промени са 1 на 0).
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Слика 26 Детекција ивице резултата логичке операције
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Слика 27 Детекција ивице сигнала (I1.1)

У решењу задатка примењена је детекција ивице сигнала. Напомена: да би овакав "тастер" могао поново да се користи, неопходно је прво укинути форсирано стање оn (Stop Forcing).

Програм:
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Пример 6
Три трофазна асинхрона мотора са краткоспојеним ротором треба да раде у једном електромоторном погону. Притиском на тастер за укључење, мотор М1 треба да почне са радом, да би се после времена t1 укључио мотор М2, а искључио мотор М1. Потом мотор М2 треба да ради време t2, после чега треба да се укључи мотор МЗ, а искључи мотор М2. Мотор МЗ треба да ради време t3, после чега треба да се укључи мотор М1, а искључи мотор МЗ. Описани циклус рада ова три мотора понавља се са периодом Т=t1+t2+t3, све док се рад погона не заустави притиском на тастер за искључење, или услед деловања биметалне заштите неког од мотора. Написати програм који ће испунити све наведене захтеве.

Решење 
Коришћени симболи:
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Програм:
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Пример 7
У једном електромоторном погону трофазни асинхрони мотори М1 и М2 треба да раде према следећем програму: притиском на тастер за укључење, мотор М1 почиње са радом, да би се после времена t1 укључио и мотор М2. Они затим истовремено раде време t2, после чега се искључује мотор М1. Мотор М2 ради још време t3, после чега се и он искључује. Помоћуједног тастера за искључење рад погона се може прекинути у било ком тренутку. Написати програм за овај погон.

Решење 
Коришћени симболи: 
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Програм:
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Пример 8
Написати програм за асинхрони мотор са краткоспојеним ротором чији се погон састоји у следећем: по притиску на тастер за укључење мотор ради време t1, после чега се аутоматски искључује и остаје искључен време t2. После тога аутоматски почиње други циклус рада и паузе, идентичан првом. По његовом завршетку, мотор се још једном аутоматски укључује, да би се после времена t1 коначно искључио. Мотор се може искључити и у било ком тренутку, притиском на тастер за искључење.

Решење:
Коришћени симболи:
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Програм:
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Пример 9
Притиском на тастер за укључење мотор М1 почиње са радом, да би се после времена t аутоматски искључио. У случају деловања његовог повратног биметалног заштитног релеа, аутоматски се укључују резервни мотор М2 и аларм, који се притиском на тзв. "тастер за квитирање" може искључити. Резервни мотор се искључује притиском на тастер за искључење, помоћу кога се може искључити и мотор М1. Написати програм за овакав електромоторни погон.
Решење 
Коришћени симболи: 
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Програм:
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Пример 10
Притиском на тастер за укључење, мотори М1 и М2 истовремено почињу да раде, да би се после времена t1 оба мотoра аутоматски искључили. Мотори остају искључени време t2, после чега се аутоматски укључује: Мотор М1, ако jе преклопни контакт једног аутомата у положају 1, или Мотор М2, ако је преклопни контакт аутомата у положају 2. Укључени мотор (М1 или М2) наставља да ради све док се не искључи притиском на тастер за искључење. Деловањем повратног биметалног заштитног релеа било ког од њих, искључују се оба мотора. Написати програм који испуњава ове захтеве.
Решење 
Коришћени симболи: 
[image: image68.emf]
"Аутомат" је бит у радној области и може да се форсира у стање оn, које симулира положај 1 аутомата, или у стање off, које симулира положај 2 аутомата.

Програм:
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